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Lecture Organization 

 Extended to 8 ECTS credits 

 G: «Vorlesung mit Übung» 

 Part I – F. Mattern 

 Part II – R. Wattenhofer 

 A: «selbständige Arbeit» 

 Graded practical assignments 
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OUTLINE 

 General Information  

 Exercise Organization 

 The Android Platform 

 Homework 
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Types of Exercises 

 Practical assignments 
 Programming on the Android platform 

 Three detailed assignments 

 Open project 

 Graded! 

 

 Theoretical exercises 
 Preparation for the exam 

 Two exercise sheets 

 Discussion of the exercises on given dates 
(according to progress of the lecture) 
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Practical Assignments 

 A1: GUI and hardware 
 04 Oct 2010 – 14 Oct 2010 (1.5 weeks) 

 

 A2: Client-server, REST, and Cloud services 
 15 Oct 2010 – 28 Oct 2010 (2 weeks) 

 

 A3: Unreliable network and vector clock 
 29 Oct 2010 – 14 Nov 2010 (2.5 weeks) 

 

 A4: Open project (with presentation) 
 15 Nov 2010 – 20 Dec 2010 (5 weeks) 
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Practical Assignments 

 Procedure 

 Teams of three 

 Develop on the emulator 

 Test on an actual Android phone 

 One HTC Desire per team 

 Individual documentation of the code 

 

 Grading 

 Individual submissions (grades) for detailed assignments 

 Team grade for open project 
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OUTLINE 

 General Information  

 Exercise Organization 

 The Android Platform 

 Homework 
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A Little History 

 09/2003: Android, Inc. founded in Palo Alto 
 

 07/2005: Google buys Android, Inc. 
 

 11/2007: Open Handset Alliance announced 

 HTC, LG, Samsung, Motorola, … 

 Texas Instruments, Intel, Nvidia, … 

 T-Mobile, Vodafone, Telecom Italia, … 
 

 09/2008: T-Mobile’s G1 launches 
 

 10/2008: Android goes open source 

 Apache license allows commercial development 

10 

Andy Rubin 
Co-Founder, Android 
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G1 (HTC Dream) 



Android Alternatives 

Android iPhone BlackBerry 
Windows 

Mobile 
Symbian 

Foundation 
Palm WebOS 

Language Java ObjectiveC JavaME/MDS 
.NET (VB/C#), 

C++ 
Symbian C++ JavaScript 

Kernel Linux Mac OS X RT OS Windows Real-Time OS Linux 

License Open Closed Closed Closed Open (02/2010) Mixed 

IDE Eclipse Xcode Eclipse Visual Studio Symbian ADT Eclipse 

IDE Platform Multiple Mac OS X Multiple Windows Windows Multiple 

Version 2.2 4.1 6.0 6.5 ^3 (S60: 5th v9.4) 1.4.5 

Handsets Multiple Apple RIM Multiple Nokia Palm 

App Install Open Registration Registration Registration Registration Open 

Sponsor Google/OHA Apple RIM Microsoft Nokia Palm 
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Android Alternatives 

Android iPhone BlackBerry 
Windows 
Phone 7 

MeeGo 
(Moblin/Maemo) 

bada 

Language Java ObjectiveC JavaME/MDS 
.NET (VB/C#), 

C++ 
C/C++ C++ 

Kernel Linux Mac OS X RT OS Windows Linux RT/Linux 

License Open Closed Closed Closed Open Closed 

IDE Eclipse Xcode Eclipse Visual Studio QTCreator Eclipse 

IDE Platform Multiple Mac OS X Multiple Windows Linux Windows 

Version 2.2 4.1 6.0 «7.0» 1.0.3 1.0 

Handsets Multiple Apple RIM Multiple Multiple Samsung 

App Install Open Registration Registration Registration Open Registration 

Sponsor Google/OHA Apple RIM Microsoft Intel/Nokia Samsung 
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Android Smartphone Market Share (U.S. 13+) 
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Android Key Points 

 Free and open for commercialization 

 Any vendor can improve (e.g., «HTC SenseUI») 

 

 Linux-based OS, Java-based Applications 

 Supports robust system and quick development 

 Highly optimized Java VM «Dalvik» 

 

 All apps are equal! 

 No core OS applications 

 3rd party apps can exchange any part of system 

(dialer, SMS, email) 
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Android Versioning 

Version API Level Release Name Kernel Release Date Note 

1.0 1 - 2.6.25 Sep 2008 Original G1 Firmware 

1.1 2 - 2.6.25 Feb 2009 G1 Update 

1.5 3 Cupcake 2.6.27 30 Apr 2009 More apps, languages, soft-keyboard 

1.6 4 Donut 2.6.29 15 Sep 2009 New search, Market, gestures, VPN 

2.0 5 Eclair 2.6.29 26 Oct 2009 Exchange, BT2.1, multitouch (e.g., Hero) 

2.0.1 6 2.6.29 03 Dec 2009 Bug fixes 

2.1 7 Flan? Eclaire 2.6.29 12 Jan 2010 WebKit updates, bug fixes 

2.2 8 FroYo 2.6.32 20 May 2010 JIT, RAM support, PUSH, apps to SD 

3.0 9 Gingerbread 2.6.35? Q4 2010? WebM video, UI improvements, ...? 

3.1 10 Honeycomb ? ? ? 
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Android Hardware 
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HTC Dream (G1) HTC Desire Samsung i9200 Galaxy S2 

Date October 2008 April 2010 Q1 2011 

Android Version 1.0 / 1.5 2.1 / 2.2 3 

Processor Qualcomm 528 MHz Qualcomm 1 GHz 2 GHz 

ROM 256 MB 512 MB 4 GB 

RAM 192 MB 576 MB 1 GB 

Display Technology TFT-LCD TFT-AMOLED / Super LCD Super AMOLED 2 

Display Size 3.2'' (320x480) 3.7'' (480x800) 4.3'' (1280x720) 

Battery 1150 mAh 1400 mAh ? 

Bluetooth 2.0 2.1 3.0 

Bluetooth Profiles A2DP (Headsets) A2DP, FTP, OPP,... ? 

WiFi 802.11 b/g 802.11 b/g 802.11 b/g/n 

Sensors 
GPS, compass, 
accelerometer 

GPS, compass, accel., 
proximity, ambient light 

GPS, accel., gyroscope, 
proximity, ambient light 



Android Hardware 
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 Tablets and more 
Barnes&Noble nook 

Dell Streak 

Archos 8 

1 GHz, 5'' (480x800), b/g 

600 MHz, 8'' (800x600), b/g 

~600 MHz, 6'' E ink 

+ 3.5'' LCD, b/g 

Samsung Galaxy Tab P1000 

1 GHz, 7'' (1024x600), 

a/b/g/n 



Android Platform 
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Physical Hardware 

Linux 2.6 Kernel 
Hardware Abstraction Layer 
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Android Security Model 

 Each application runs as individual Linux user 
 Created upon application installation by Android 

 Per default no access to other apps, data 

 Apps can declare needed access permissions 
 Access to GPS location, Internet, auto-start, ... 

 Multiple apps can share single user ID 
 Allows direct access to each others data 

 Apps needs to declare the same android:sharedUserId 

 All apps need to be signed with the same digital signature 

 All applications include digital signature 
 Generic default signature while developing 

 Needs to be properly signed with your certificate when distributing 
(e.g., selling on Market) 
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Android Software Stack 
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Linux Kernel 

Display Driver Camera Driver Bluetooth Driver M-Systems Driver Binder (IPC) Driver 

USB Driver Keypad Driver WiFi Driver Audio Drivers Power Management 

                                  Libraries 

SGL 

OpenGL/ES 

Surface Manager 

SSL 

FreeType 

Media Framework 

libc 

WebKit 

SQLite 

Android Runtime 

Dalvik Virtual Machine 

Core Libraries 

Application Framework 

Package Manager 

Activity Manager 

Telephony Manager 

Windows Manager 

Resource Manager 

Content Providers 

Location Manager 

View System 

XMPP Service 

Notification Manager 

Applications 

Home Contacts Phone Browser YOUR APPS... 
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http://www.youtube.com/watch?v=QBGfUs9mQYY&feature=user


Android Key Terms 

 Activity 
 «Logical unit of user action» (cf., window of PC application) 

 Typically a single screen with multiple Views 

 Also UI-less (Service) 

 

 View 
 Hierarchical UI element 

 Combine in View Groups 

 

 Service 
 Faceless task (Activity) that runs in background (e.g., music player) 
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Android Key Terms 

 Intent 
 Launches activities or couples multiple Activities 

 Passive data structure 

 Also describes operation to be performed 

 Explicit by calling the exact class 

 Implicit by using «Intent filters» to find matching components 

 

 BroadcastReceiver 
 Responds to broadcast announcements 

(e.g., «headset plugged in» Intent by system) 

 Can wake up your application or start an Activity 

 Or just notify user 
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Android Key Terms 

 ContentProvider 
 Enables application to share data 

(e.g., to offer contacts to other apps) 

 Can use file system, SQLite, or «any way you want» 

 Other apps use a ContentResolver to access the data 

 

 

 

 

 See also 
 http://www.youtube.com/watch?v=QBGfUs9mQYY&feature=user 

 http://developer.android.com/guide/topics/fundamentals.html 
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Program Lifecycle 

 Android multi-tasking 
 OS tries to maintain application 

process as long as possible 

 If short on memory, low priority 
processes may be killed 

 

 Activity States 
 Running 

 Paused 

 Stopped 

 Finished/killed 
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Triggered Methods I 
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Triggered Methods II 
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Online Resources 

 Android developers: developer.android.com 
 The Guide (Intro): /guide/index.html 

 Resources (Tutorials): /resources/index.html 

 Videos: /videos/index.html 

 

 Android blogs 
 http://android-developers.blogspot.com 

 http://www.androidguys.com/ 

 … 

 

 Google 
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OUTLINE 

 General Information  

 Exercise Organization 

 The Android Platform 

 Homework 
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Teams 

 Form teams of 3 students each 

 Vote a representative 

 Send representative to collect the HTC Desire 
 

 Monday 2 pm – 4 pm CNB H 107.2 

 Tuesday 2 pm – 4 pm CNB H 108 

 Wednesday 11am – 1 pm CNB H 108 

 Thursday 2 pm – 4 pm CNB H 103.1 

 Friday 2 pm – 4 pm CNB H 108 
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HTC Desire 

 Check package for completeness 

 Charge the battery first 

 Configure Wi-Fi access 

 «Settings > Wireless & networks > Wi-Fi settings» 

 Update to Android 2.2 

 «Settings > About Phone > System software updates > Check now» 

 Enable debugging 

 «Settings > Applications > Development > USB debugging» 

 

 Get familiar with the device 
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Toolchain Installation 

 Java SE JDK 6 
 http://www.oracle.com/technetwork/java/javase/downloads/index.html 

 

 Android SDK 
 http://developer.android.com/sdk/index.html 

 Extract to your disk somewhere 
 

 Eclipse 3.5 «Galileo» (e.g. IDE for Java Developers) 
 http://www.eclipse.org/downloads/ 

 Add ADT Plugin («Help > Install New Software») 

 Software Site https://dl-ssl.google.com/android/eclipse/ 

 Set up SDK location («Window > Preferences > Android») 

 Install API8 packages («Window > Android SDK and AVD Manager») 
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Windows 
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Ubuntu Linux 

 USB Configuration Rules 
 Log in as root 

 Create file /etc/udev/rules.d/51-android.rules 

 For Gusty/Hardy insert 

 

 

 For Dapper insert 

 

 

 Change permissions 
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SUBSYSTEM=="usb", SYSFS{idVendor}=="0bb4", MODE="0666" 

SUBSYSTEM=="usb_device",SYSFS{idVendor}=="0bb4",MODE="0666" 

chmod a+r /etc/udev/rules.d/51-android.rules 
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Mac OS X 

 10.6.x only includes Java 6 (both 32- & 64-bit version) 

 64-bit version is used by default 

 May cause problems with Eclipse ADT 

 Solution: Make 32-bit version default 

 Run Java Settings application 

 Bring 32-bit Java 6 to the top of the list for «Java Programs» 
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Computer Labs 

 Windows 
 Drivers, Eclipse, and ADT Plugin are installed 

 Download and extract Android SDK to your home directory 

 Set up SDK location in Eclipse 

 Install API8 packages 

 Linux 
 USB configuration already done 

 Download and extract Android SDK to your home directory (or /local/) 

 Red Hat tool ignores empty folders  recreate «platforms» and «add-ons» folders 

 Update Eclipse («Help > Install New Software») 

 Software Site http://download.eclipse.org/eclipse/updates/3.5 

 Install ADT Plugin 

 Set up SDK location 

 Install API8 packages 
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Test Toolchain 

 Can create an Android project? 

 A sample project compiles? 

 Driver for HTC Desire working? 

 Sample application is installed correctly? 

 Create a virtual device and run the emulator! 
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OUTLINE 

 General Information  

 Exercise Organization 

 The Android Platform 

 Homework 
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Next Android Lesson 

 Monday, 04 October 2010 

 

 Programming introduction 

 Live hacking 

 First assignment 

 

 Install the toolchain until then! 
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QUESTIONS? 
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